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Introduction  
The EMI Analyser System is specially developed for EMI research on hybrid and electric 
(racing) cars. It consists of 3 main components: 

1. Receptor Device 
2. EMI Analyser Application 
3. NF (Near Field) Antenna 

 
The EMI Analyser application (Analyser) is used to visualize the measurements and control 
the Receptor. The Analyser is available for Windows. 
 
This manual describes the EMI Analyser Application. 
For the Receptor device, please refer to the Receptor User Manual 
 

Screenshot 1. Start up screen 
 
 
The system has 3 operation modes: 
 
In Analyse mode the Receptor is connected to the NF Antenna, supplied by TMS. The 
measurements are filtered by an analog low pass filter (0 - 10 MHz). The measurements are 
shown in real time as a function of time (oscilloscope window) and as a function of 
frequency (spectrum window). The repetition rate, harmonics and amplitude of the EMI can 
be analyzed, giving more inside on the source of the EMI. All measurements can be recorded 
in an EMI file. The Analyser can replay the EMI-file. Analyse mode is mostly used by teams 
for EMI source finding. 
 
In Scan mode, the Receptor works as a logarithmic amplifier and the Analyser shows the 
magnitude versus time. This measurement is triggered with a user defined trigger level. All 
measurements can be saved in a SCN-file. The SCN-file can be read with the Analyser. 
Scan mode is mostly used by federations to inform teams on EMI issues. 
 
In Rolling Peak mode, the Receptor works as in Analyse mode accept that it saves all 
measurements in internal non-volatile memory when powered until the memory is full. 
Log mode is mostly used by engineers in factories for car design issues that influence the 
Transponder signal. 
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Connection  
The Receptor has two communication interfaces, USB-C and Ethernet. 
Both interfaces can be used for power supply and data at the same time. 
 

 
 

Screenshot 2. Device Selection Dialog 
USB Interface 
 
Connect the Receptor using an USB-C cable to the computer. 
- Select from the menu bar: Device → Open or from start-up 'Open Device'  
- Select from the list ‘Receptor (com port)’ 
 
 
Ethernet Interface 
 
Power the Receptor via the DC power supply, USB-C port or with passive POE. 
 
Connect the Receptor to your LAN with a CAT-5 cable. 
- Select from the menu bar: Device → Open or from start-up 'Open Device'  
- Select from the list ‘EMI Acquisition Receptor (IP address – EA address)’. 
 
When the Receptor is behind a firewall, it is possible the Receptor is not shown in the list. In 
this case the IP address can be manually entered below.  
 
Please refer to the Receptor User Manual to change the Network Settings of the Receptor via 
the Receptor Web Interface. 
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Modes 
 
Analyse Mode 
 
Analyse mode is mostly used by teams to do ‘static’ tests in the factory or pit box after an 
EMI issue is found. To start searching for an EMI source switch to Analyse mode by clicking 
the TAB ‘Analyse’ in the upper left corner. 
 

 
In Analyse mode the EMI Application will show real time signal information. 
 
The upper window shows the received signal in the time domain, which is comparable with 
what an oscilloscope would show. 
The lower window shows the received signal in the frequency domain, which is comparable 
with what a spectrum analyser would show. 0-20 MHz is shown. 
 

 
Screenshot 3. Analyse Mode, sine wave at 1.740 MHz 

 

Above screenshot 3 shows an almost clean sine wave at 1.740 MHz coming from a signal 
generator. The signal generator however also produces an approximately 40dB lower 
unwanted signal at 1.032MHz as can be seen in the lower (spectrum analyser) window. 
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Screenshot 4. Analyse Mode, block wave at 1.740 MHz 

 
Above screenshot 4 shows block wave at 1.740 MHz coming from a signal generator. The 
unwanted signal frequency has slightly changed to 0.963 MHz as can be seen in the lower 
(spectrum analyser) window. As this is a block wave al harmonic frequencies due to fast 
slopes in the block wave signal are shown i.e; 3.480 MHz, 5.220 MHz, 6.960 MHz etc. 
 
Above principal is used to find EMI sources by finding the base frequency of the source. To 
find the actual physical location/device that is generating the EMI with help of the NF 
Antenna which is handheld/portable and can therefore be used to search for the EMI source. 
 
In addition to the real time view a few options are available in the Analyse mode. These 
options can be found in the top menu bar. 
 

 
 
Live  Real time signal analysis. 
Average Shows an average (blue) line in the live spectrum. 
Max Hold Shows a peak hold line (red) in the live spectrum. 
Pause Live mode is paused and EMI-file the screen is not updated with new 

measurements. 
Record Record the measurements for later review. 
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Near Field Antenna 
 
The near field (NF) antenna is a small handheld device connected to the Receptor via a 
COAX cable. The antenna can be fixed at a specific location and successive measurements 
can be compared to determine changes in EMI when making changes to the surrounding 
electronics or cables. 
 
To locate the actual source of EMI, the antenna can be moved around and the software will 
show the received EMI in real time. 
 
 
Static EMI Source Finding 
 
Typical workflow searching for EMI source(s) with help of the Analyse mode. 
 

• Start the EMI Analyser application 
• Connect the TMS Receptor with an USB cable or network cable.  
• Connect the NF antenna to the receptor 
• Select the TAB “Analyse” 
• The upper graph shows the measured signal versus time 
• The lower graph shows the measured signal magnitude versus frequency  
• Place the NF Antenna in the transponder position 
• Create a snapshot of the spectrum by clicking on the “options” button in the right-

bottom corner of the spectrum graph to save it 
• Move the NF Antenna around and check for changes in the spectrum graph 

 
 
Replay EMI analysis 
 

To replay EMI measurement, at startup choose ‘Open File’ instead of connecting to the 
Receptor or open the .emi file from the ‘File’ menu and choose ‘Open’. 
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Scan Mode 
 
San mode is mostly used by federations to do constant ‘dynamic’ tests on track. 
The application connects to the Receptor to get the scans and connects to the MYLAPS X2 
server to get the Transponder timestamps. Connect to the MYLAPS X2 Server by clicking on 
the Server/Network icon.  
 
Configure the right X2 Server, user credentials and choose the loop that is connected to the 
Receptor. 

 
 
The Receptor is equipped with a GPS receiver to synchronise in time with the X2 Server. To 
start scanning for noise coming from a competitor switch to Scan mode by clicking the TAB 
‘Scan’ in the upper left corner. 
 
Make sure both the Receptor and X2 Server are connected before starting the Scans. 
 

 
 
In Scan mode the EMI Application will show real time signal information. 
 
A time base will be shown. This mode is especially useful in finding the location of radiated 
emissions coming from a car using its hybrid system at full power. 
As layout of cables and structural design of the car influences the way radiated emissions is 
generated these scans are very useful to analyze changes made to the car design. 
 
To capture the scans a trigger level can be set at the lower left corner of the screen. Each time 
a signal with a magnitude above the trigger level is received, the analyser will save a scan. 
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Screenshot 6. Scan mode 

Above screenshot 6 shows an example of a hybrid racing car with a front and rear 
Transponder passing a loop antenna. 
 
Set the signal level trigger level for each scan with help of the slider vertical slider on the 
right. 
 
The horizontal slider can be used optional to shift the trigger moment in time. 
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Loop Antenna 
 
Connect the Receptor input with a 75ohm coax cable to a standard loop antenna of 60cm 
width. The track position of the loop should be at a location where it is expected that the 
power unit will use its electrical (MGU) system. 
 
 
Dynamic EMI Source Finding 
 
Typical workflow searching for EMI source(s) with help of the scan mode 
 

• Connect the TMS Receptor with a coax cable to a track loop 
• Make sure the Receptor has good GNSS reception with an external GNSS antenna 
• Start the EMI Analyser application 
• Connect to the TMS Receptor 
• Connect to a MYLAPS X2 Server if available (synchronize with Transponder signals) 
• Switch to the scan tab 
• Set the signal trigger level above the average noise level received in order to avoid 

false triggers 
• Make sure passings are captured when there is track activity 
• Save all passings to file 

 
A timeboxed frame of scans can be exported to a file location with help of the exporter tool 
in order to distribute the information. 
 
 
The scans can be useful to determine where EMI sources are physically located. 
 
This is best described in the below example picture. 
As the transponders are timestamped in the scan the transponder location on the car can be 
synchronized to these timestamps. 
 
In the below example the higher noise (dens green signals) seem to be coming from the 
middle of the car. 
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Replay EMI scans 
 
Al scans can be retrieved and reviewed by opening the saved scans file from the file menu.  
 
 
Rolling Peak Mode 
 
In Rolling Peak mode, the Receptor stores all measurements into internal non-volatile 
memory when powered. The Rolling Peak mode can be used to determine signal signatures 
coming from a Transponder. This kind of measurements require a Timing Transponder 
specialist to analyze issues with Transponder installations. 
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Diagnostics 
 
When a Receptor is connected, the voltage and current can be monitored by clicking the 
status bar showing the connected device name. This will show two graphs with the voltage 
and current from the last hour. 

 
Screenshot 9. Device status 
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Tools 
 
Harmonic Calculator 
 

Screenshot 10. Harmonic Calculator 

Select from the menu bar: Tools → Harmonics Calculator 
The Harmonic Calculator can be used to find the fundamental frequency of a signal by 
calculating the harmonics. 
 
Measure Tool 
 

Screenshot 11. Measurement tool 



 
 

V2.0 TMS Products B.V.           ©2026 - 13 - 

The Measure Tool is available in every graph. Left click in the graph will add a measure 
point to the graph and the Measure Tool Dialog will appear. The second left click will add 
another measure point. The distance between the two measure points (delta X and delta Y) 
are calculated. A third left click will hide the Measure Tool. 
 
Exporter Tool  

 
Select from the menu bar: Tools → Exporter 
The Exporter can be used to distribute scans to teams by assigning a TLA and team to a 
Transponder number and specifying the folder to export the data to. 
 
Save Graph 
Each graph can be saved as an PNG image. Select Options at the right bottom of the graph 
and then select Save… 
 

 
 

 

 

 



 
 

V2.0 TMS Products B.V.           ©2026 - 14 - 

DISCLAIMER 
 
This product has been designed with the utmost care. However, TMS Products B.V. accepts 
under no circumstances liability in any form whatsoever for damage or injury resulting from 
or arising out of the use of this product. 
 
We make every effort to provide correct and up-to-date information about our products 
however, no liability is accepted for incomplete or incorrect information in this manual. 
 
This product is designed, among other things, to improve safety and performance in 
motorsport. However, it is only an aid to the user which, when everything is fully functional, 
may make the situation on a track safer. However, the user remains responsible for his own 
safety at all times and cannot claim any liability in case of malfunction of the product or the 
products linked to it. 
 
The sale of products governed under this publication are covered by TMS Products B.V. 
Products Sales Terms and Conditions and can be found here: 
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